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DEMO MANUAL DC1649A

 DESCRIPTION

LTC6945 
Ultralow Noise and Spurious

Integer-N Synthesizer

Demonstration circuit 1649A features the LTC®6945, an 
ultralow noise and spurious integer-N synthesizer.

DC1649A provides 50Ω SMA connectors for the reference 
frequency (REF+), the reference output buffer (REFO), 
and the two single-ended RF outputs (RF+ and RF–). L, LT, LTC, LTM, Linear Technology and the Linear logo are registered trademarks and 

PLLWizard and QuikEval are trademarks of Linear Technology Corporation. All other trademarks 
are the property of their respective owners.

Demonstration circuit 590 is used for SPI communication 
with the LTC6945, controlled by the supplied PLLWizard™ 
software. 

Design files for this circuit board are available at 
http://www.linear.com/demo

Figure 1. DC1649A Inputs and Outputs
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TYPICAL DC1649A REQUIREMENTS AND CHARACTERISTICS

QUICK START PROCEDURE

PARAMETER INPUT OR OUTPUT PHYSICAL LOCATION DETAILS

3.3V Power Supply Input J9 and J10 Banana Jacks Low Noise and Spur-Free 3.3V, 95mA

5V Charge Pump Power Supply Input J11 and J12 Banana Jacks Low Noise and Spur-Free 5V, 35mA

5V VCO Power Supply Input “V+VCO” Turret Low Noise and Spur-Free 5V, 18mA

REF+, Reference Frequency Input J2 SMA Connector Low Noise 10MHz or 100MHz*, 6dBm into 
50Ω, See Note 1

REFO, Buffered Reference Output J1 SMA Connector Frequency = fREF, 0dBm

RF+ and RF– Two Outputs J6 and J7 SMA Connectors 902MHz to 928MHz* in 250kHz* Steps, 0dBm

Loop Bandwidth Set by Loop Filter Component Values 7kHz*

*These frequencies are for the “DC1649A-10MHz.pllset “or” DC1649A-100MHz.pllset” files and included VCO.

Note 1: A low noise 10MHz or 100MHz reference frequency, such as the 
Wenzel 501-04608A or 501-04516D OCXO, is recommended. If using a 
different frequency, make sure to update the Fref and R_DIV boxes under 
the System tab in PLLWizard so that Fpfd is still 250kHz. For example, if a 
20MHz clock is used, Fref should be changed to 20MHz and R_DIV to 80. 

Ref BST and FILT under the System tab in PLLWizard might need to be 
changed if the reference frequency and/or power is different than what is 
recommended in the table above. More information can be found in the 
LTC6945 data sheet.

The DC590 and PLLWizard application are required to 
control the DC1649A through a personal computer (PC).

DC590B Configuration

The DC590’s QuikEval™ drivers must be installed before 
the DC590 will be able to communicate with the LTC6945. 
To configure the DC590, follow the procedure below, start-
ing with Step 1. If you have already installed the DC590 
software previously, skip to Step 5.

Note: Once the QuikEval software is installed, the applica-
tion Does Not need to be executed to run PLLWizard or to 
control the DC1649A.

1. Do Not plug in the DC590 before running the installation 
program.

2. Download the QuikEval installation program from 
http://www.linear.com/software.

3. Run the QuikEval installation program and follow the 
on-screen instructions. More detailed installation infor-
mation may be found in the DC590’s Quick Start guide.

4. Exit the QuikEval program once the installation is com-
plete, as it is not needed to run the PLLWizard software.

5. Place the DC590 jumpers in the following positions:

 JP4 - EE Must be in the “EN” position.

 JP5 - ISO ”ON” must be selected.

 JP5 - SW ”ON” must be selected.

 JP6 - VCCIO “3.3V” must be selected. This sets the SPI 
port to 3.3V operation.

6. Connect the DC590 to one of your computer’s USB 
ports with the included USB cable.
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QUICK START PROCEDURE

Figure 2. DC590 Jumper and Connector Locations

PLLWizard Installation

The PLLWizard software is used to communicate with 
the LTC6945 synthesizer. It uses the DC590 to translate 
between USB and SPI-compatible serial communications 
formats. It also includes advanced PLL design and simula-
tion capabilities. The following are the PLLWizard system 
requirements:

n Windows Operating System: Windows XP, Windows 
2003 Server, Windows Vista, Windows 7

n Microsoft .NET 2.0 or later

n Windows Installer 3.1 or later

n Linear Technology’s QuikEval and DC590 hardware

Microsoft .NET

You must have Microsoft .NET 2.0 or later installed on 
your computer. PLLWizard will not run without it. Note 

that Windows Vista and Windows 7 have at least version 
3.5 preinstalled. 

To manually determine your version of .NET using Win-
dows XP, click

Start Menu → Settings → Control Panel → Add or 
Remove Programs

Depending upon your .NET version, choose one of 
two PLLWizard setup programs, downloaded from 
http://www.linear.com/software.

Either setup program will automatically install Microsoft 
.NET if a compatible .NET version is not found. But, the 
installation source depends upon which file you down-
loaded from Linear Technology’s website. You should pick 
one of the following two choices, depending upon your 
version of .NET.
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QUICK START PROCEDURE

Table 1. PLLWizard Installation File

FILE .NET 2.0 SOURCE

PLLWizardSetup.exe latest version downloaded from 
Microsoft

PLLWizardSetup_net20.exe 2.0 SP2 included (much larger file size)

n Choose PLLWizardSetup if you have .NET 2.0 or later, 
have Windows Vista or Windows 7, or if you have less 
than .NET 2.0 but want the latest .NET installed.

n Choose PLLWizardSetup_net20 if you have less than 
.NET 2.0, and want faster installation (no additional 
Microsoft downloads are needed, but the file size is 
much larger).

The setup file will verify and/or install Microsoft .NET and 
install PLLWizard. Refer to the Help menu for software 
operation.

DC1649A Configuration

1. Connect an appropriate reference frequency source (at 
J2) and signal analyzers (at J6 and/or J7) using the 
SMA connectors (see Figure 1 and the Typical DC1649A 
Requirements and Characteristics table).

2. Choose the MUTE jumper setting: JP1 - GND/3.3V MUTE 
position. Select GND to mute the RF output, 3.3V to 
un-mute.

3. Connect the GND, 3.3V, and 5V banana jacks and the 
“V+VCO” turret to a power supply and apply power (see 
Figure 1 and the Typical DC1649A Requirements and 
Characteristics table).

4. Connect the DC590 to the DC1649A with the provided 
ribbon cable.

5. Run the PLLWizard application.

6. In PLLWizard, click File → Load Settings and point to the 
“DC1649A-10MHz.pllset” or “DC1649A-100MHz.pllset” 
file found in the PLLWizard installation directory (typically 
Program Files → LTC → PLLWizard → Set Files).

The red LED on DC1649A should turn on indicating that 
the loop is locked at 914MHz.

Troubleshooting

If the red LED does not illuminate, follow the instructions 
below:

1. Verify that you are able to communicate with the 
DC1649A. The bottom status line in PLLWizard should 
read “LTC6945” and “Comm Enabled”. Refer to PLL-
Wizard’s Troubleshoot and Help if not.

2. Verify that the 3.3V, 5V and “V+VCO” have the correct 
voltages on them and that the reference frequency is 
applied to the REF+ SMA input.

If the red LED is on but you cannot detect an RF out-
put, make sure jumper JP1 is at the 3.3V position. Run 
Help → Troubleshoot in PLLWizard if the problem is not 
resolved.

Figure 3. PLLWizard Screenshot
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DC1649A RECONFIGURATION

DC1649A is flexible and allows the use of a variety of VCOs 
and the choice to employ either an active or passive loop 
filter. The following covers the hardware reconfiguration of 
DC1649A. Refer to PLLWizard’s Help and the LTC6945 data 
sheet to better understand how to change programmed 
parameters on the DC1649A.

Installing Different Tunable Devices

DC1649A permits the use of different tunable oscillators, 
like VCOs and VCXOs. There are two different oscillator 
footprints on the board: U3, which accommodates the 
popular 0.5in × 0.5in package, and U4, which accom-
modates another common 14mm × 9mm package with 
four or six pins. An external connectorized VCO can also 

drive the LTC6945 through J5. Table 2 gives options to 
customize the DC1649’s VCOs. When using an active loop 
filter, an additional pole is required in the loop filter to limit 
the op amp’s noise contribution to the VCO phase noise.

Selecting Loop Filter Type

DC1649A can use either an active or a passive loop filter, 
depending upon the application. Some VCO tuning volt-
age ranges are greater than the LTC6945 charge pump 
voltage range (refer to the LTC6945 data sheet). In such 
cases, an active loop filter using an op amp can deliver 
the required tuning voltage. Table 3 summarizes these op-
tions. PLLWizard helps determine the component values 
listed in this table.

Table 2.  Oscillator Options

TUNABLE 
DEVICE

SELECTION 
COMPONENTS

RESISTOR FOR 
ADDITIONAL POLE

CAPACITOR FOR 
ADDITIONAL POLE POWER

ENABLE PIN OR 
REMARKS

U3 C26 ≅ 100pF, depopulate 
R17, C25 and C28

R10 = 0Ω for passive 
loop filter

R10 ≅ 100Ω for active 
loop filter

C27 = Open for passive 
loop filter

Pick C27 such that 
1/(2π • R10 • C27) ≅ 15 � 
the loop bandwidth in Hz 
for active loop filter

Determined by U3 
device power supply 
specification, up to 24V 
applied to “V+VCO” turret

U4 C28 ≅ 100pF, depopulate 
R10, C25 and C26

R17 = 0Ω for passive 
loop filter

R17 ≅ 100Ω for active 
loop filter

C32 = Open for passive 
loop filter

Pick C32 such that 
1/(2π • R17 • C32) ≅ 15 � 
the loop bandwidth in Hz 
for active loop filter

Determined by U4 
device power supply 
specification, up to 24V 
applied to “V+VCXO” 
turret

Use “EN” turret to control 
pin 2 of U4

External C25 ≅ 100pF, R15 = 0Ω, 
depopulate R13, C26 
and C28

Selection components 
are for an active loop 
filter. Connect the external 
VCO output to J5. Use 
“CPGAIN” to tune the 
external device

Table 3. Loop Filter Options

LOOP FILTER 
TYPE

SELECTION 
RESISTORS

RZ FROM 
PLLWizard

CI FROM 
PLLWizard

CP FROM 
PLLWizard POWER

CPINV BOX, SYSTEM 
TAB IN PLLWizard

Passive R14 and R16 = 0Ω, 
depopulate R13 and 
R15

RZ_P CI1_P in parallel 
with CI2_P

CP_P None Unchecked

Active R13 (except when 
using an external 
VCO) and R15 = 0Ω, 
depopulate R14 and 
R16

RZ_A CI1_A in parallel 
with CI2_A

CP_A Determined by the 
maximum allowed 
tune voltage of the 
populated VCO (U3 
or U4), up to 24V 
applied to “V+OA” 
turret

Checked
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ITEM QTY REFERENCE PART DESCRIPTION MANUFACTURER/PART NUMBER

1 0 CI1_P, CI1_A, C27, C32, CP_A Opt., 0603

2 0 CI2_A Opt., 1206

3 1 CI2_P Cap., C0G, 0.1μF, 50V, 5%, 1206 Murata, GRM31C5C1H104JA01L

4 1 CP_P Cap., X7R, 8200pF, 50V, 10%, 0603 Murata, GRM188R71H822KA01D

5 3 C1, C19, C33 Cap., Tantalum, 47μF, 35V, 10%, 7361 AVX, TAJV476K035RNJ

6 4 C2, C6, C21, C35 Cap., X7R, 0.1μF, 50V, 10%, 0805 AVX, 08055C104KAT2A

7 2 C3, C16 Cap., Tantalum, 330μF, 10V, 10%,7343 AVX, TPME337K010R0035

8 10 C4, C11, C17, C24, C30, C36, C39, 
C41, C43, C44

Cap., X5R, 0.1μF, 10V, 10%, 0402 AVX, 0402ZD104KAT2A 

9 4 C5, C12, C18, C31 Cap., X5R, 1μF, 10V, 10%, 0402 AVX, 0402ZD105KAT2A

10 1 C7 Cap., Tantalum, 47μF, 20V, 10%, 7343 AVX, TAJD476K020RNJ

11 2 C8, C15 Cap., X7R, 470pF, 50V, 10%, 0402 AVX, 04025C471KAT2A

12 3 C23, C34, C45 Cap., X7R, 0.01μF, 16V, 10%, 0402 AVX, 0402YC103KAT2A

13 0 C25, C28 Opt., 0402

14 5 C26, C29, C37, C38, C42 Cap., NPO, 100pF, 16V, 10%, 0402 AVX, 0402YA101KAT2A

15 1 D1 LED, RED Panasonic, LN1251CTR

16 10 E3, E6, E11-E18 Turret, Testpoint, 2501 Mill-Max, 2501-2-00-80-00-00-07-0  

17 1 JP1 Headers, 3 Pins, 2mm Ctrs.  Samtec, TMM-103-02-L-S

18 1 XJP1 Shunt, 2mm Ctrs.  Samtec, 2SN-BK-G

19 5 J1, J2, J5, J6, J7 Con., SMA 50Ω Edge-Launch E. F. Johnson, 142-0701-851

20 0 J3, J4 Con., SMA 50Ω Straight Mount Opt.

21 1 J8 Con., Header, 14 Pin, 2mm Molex, 87831-1420

22 4 J9, J10, J11, J12 Jack, Banana Keystone, 575-4

23 0 L1 Opt., 0402

24 2 L2, L3 Ind., Wirebound, 68nH, ±5%, 0402 Coilcraft, 0402HPH-68NXJL

25 1 RZ_P Res., Chip, 806, 1/10W, 1%, 0603 Vishay, CRCW0603806RFKEA

26 5 R1, R2, R25, R26, R27 Res., Chip, 4.99k, 1/16W, 1%, 0402 Vishay, CRCW04024K99FKED

27 1 R4 Res., Chip, 330, 1/16W, 1%, 0402 Vishay, CRCW0402330RFKED

28 1 R5 Res., Chip, 51.1, 1/16W, 1%, 0402 Vishay, CRCW040251R1FKED

29 4 R7, R8, R18, R19 Res., Chip, 200k, 1/16W, 1%, 0402 Vishay, CRCW0402200KFKED

30 4 R9, R10, R14, R16 Res., Chip, 0Ω, 0603 Vishay, CRCW06030000Z0EA

31 3 R12, R21, R22 Res., Chip, 100, 1/16W, 1%, 0402 Vishay, CRCW0402100RFKED

32 0 R13, R15, R17, RZ_A Opt., 0603

33 0 R23, R24 Res., Chip, 0402, Opt.

34 1 U1 I.C. LTC6945IUFD, QFN28UFD Linear Technology Corp., LTC6945IUFD

35 1 U2 Low Noise Amp, S0-8 Linear Technology Corp., LT1678CS8#PBF

36 1 U3 (1 Reel + 1 Tape, PbF) Voltage Controlled Oscillator – VC0 Crystek, CVCO55CL-0902-0928

37 0 U4 Crystal Oscillator, Opt.

38 2 U5, U6 I.C., Dual Buffer, SC-70 6-Lead Fairchild Semi., NC7WZ17P6X

39 1 U7 I.C., Dual Transceiver, SC-70 6-Lead NXP, 74LVC1T45GW

40 1 U8 I.C., Serial EEPROM, TSSOP-8 Mircochip, 24LC24A-I/ST 

41 4 4 Corners Standoff, Nylon, 0.50, 1/2" Keystone, 8833 (Snap On)

42 2 Stencils (Top and Bottom) Stencil, DC1649A-4

PARTS LIST Number of Boards = 325



7 d
c1

6
4
9
afa

D
E
M

O
 M

A
N

U
A

L
 D

C
1

6
4

9
A

S
C
H

E
M

A
T
IC

 D
IA

G
R

A
M

1

1

2

2

3

3

4

4

5

5

6

6

7

7

8

8

A A

B B

C C

D D

NOTE: UNLESS OTHERWISE SPECIFIED

1. ALL RESISTORS ARE IN OHMS, 0402

ALL CAPACITORS ARE IN MICROFARADS, 0402.

3.3V

GND

0805
7343

MUTE

7343

VCO

902 - 928 MHz

ASSY U3
*
-A CVCO55CL-0902-0928

*

3.3V

3.3V

3.3V3.3V

3.3V 3.3V

5V

V+VCO

V+VCXO

3.3V

V+VCO3.3V

V+OA

5V

5V

CS

SCLK

SDO

SDI

REVISION HISTORY
DESCRIPTION DATEAPPROVEDECO REV

MICHEL A.PRODUCTION4 11-01-11__

REVISION HISTORY
DESCRIPTION DATEAPPROVEDECO REV

MICHEL A.PRODUCTION4 11-01-11__

REVISION HISTORY
DESCRIPTION DATEAPPROVEDECO REV

MICHEL A.PRODUCTION4 11-01-11__

SIZE

DATE:

IC NO. REV.

SHEET OF

TITLE:

APPROVALS

PCB DES.

APP ENG.

TECHNOLOGY Fax: (408)434-0507

Milpitas, CA 95035
Phone: (408)432-1900

1630 McCarthy Blvd.

LTC Confidential-For Customer Use Only

CUSTOMER NOTICE
LINEAR TECHNOLOGY HAS MADE A BEST EFFORT TO DESIGN A
CIRCUIT THAT MEETS CUSTOMER-SUPPLIED SPECIFICATIONS;
HOWEVER, IT REMAINS THE CUSTOMER'S RESPONSIBILITY TO
VERIFY PROPER AND RELIABLE OPERATION IN THE ACTUAL
APPLICATION.  COMPONENT SUBSTITUTION AND PRINTED
CIRCUIT BOARD LAYOUT MAY SIGNIFICANTLY AFFECT CIRCUIT
PERFORMANCE OR RELIABILITY.  CONTACT LINEAR
TECHNOLOGY APPLICATIONS ENGINEERING FOR ASSISTANCE.

THIS CIRCUIT IS PROPRIETARY TO LINEAR TECHNOLOGY AND

SCHEMATIC

SUPPLIED FOR USE WITH LINEAR TECHNOLOGY PARTS. SCALE = NONE

www.linear.com

4

11/01/2011, 02:18 PM 1 2

ULTRALOW NOISE AND SPURIOUS INTEGER-N SYNTHESIZER

KIM T.

MICHEL A.

N/A
LTC6945IUFD

DEMO CIRCUIT 1649A

SIZE

DATE:

IC NO. REV.

SHEET OF

TITLE:

APPROVALS

PCB DES.

APP ENG.

TECHNOLOGY Fax: (408)434-0507

Milpitas, CA 95035
Phone: (408)432-1900

1630 McCarthy Blvd.

LTC Confidential-For Customer Use Only

CUSTOMER NOTICE
LINEAR TECHNOLOGY HAS MADE A BEST EFFORT TO DESIGN A
CIRCUIT THAT MEETS CUSTOMER-SUPPLIED SPECIFICATIONS;
HOWEVER, IT REMAINS THE CUSTOMER'S RESPONSIBILITY TO
VERIFY PROPER AND RELIABLE OPERATION IN THE ACTUAL
APPLICATION.  COMPONENT SUBSTITUTION AND PRINTED
CIRCUIT BOARD LAYOUT MAY SIGNIFICANTLY AFFECT CIRCUIT
PERFORMANCE OR RELIABILITY.  CONTACT LINEAR
TECHNOLOGY APPLICATIONS ENGINEERING FOR ASSISTANCE.

THIS CIRCUIT IS PROPRIETARY TO LINEAR TECHNOLOGY AND

SCHEMATIC

SUPPLIED FOR USE WITH LINEAR TECHNOLOGY PARTS. SCALE = NONE

www.linear.com

4

11/01/2011, 02:18 PM 1 2

ULTRALOW NOISE AND SPURIOUS INTEGER-N SYNTHESIZER

KIM T.

MICHEL A.

N/A
LTC6945IUFD

DEMO CIRCUIT 1649A

SIZE

DATE:

IC NO. REV.

SHEET OF

TITLE:

APPROVALS

PCB DES.

APP ENG.

TECHNOLOGY Fax: (408)434-0507

Milpitas, CA 95035
Phone: (408)432-1900

1630 McCarthy Blvd.

LTC Confidential-For Customer Use Only

CUSTOMER NOTICE
LINEAR TECHNOLOGY HAS MADE A BEST EFFORT TO DESIGN A
CIRCUIT THAT MEETS CUSTOMER-SUPPLIED SPECIFICATIONS;
HOWEVER, IT REMAINS THE CUSTOMER'S RESPONSIBILITY TO
VERIFY PROPER AND RELIABLE OPERATION IN THE ACTUAL
APPLICATION.  COMPONENT SUBSTITUTION AND PRINTED
CIRCUIT BOARD LAYOUT MAY SIGNIFICANTLY AFFECT CIRCUIT
PERFORMANCE OR RELIABILITY.  CONTACT LINEAR
TECHNOLOGY APPLICATIONS ENGINEERING FOR ASSISTANCE.

THIS CIRCUIT IS PROPRIETARY TO LINEAR TECHNOLOGY AND

SCHEMATIC

SUPPLIED FOR USE WITH LINEAR TECHNOLOGY PARTS. SCALE = NONE

www.linear.com

4

11/01/2011, 02:18 PM 1 2

ULTRALOW NOISE AND SPURIOUS INTEGER-N SYNTHESIZER

KIM T.

MICHEL A.

N/A
LTC6945IUFD

DEMO CIRCUIT 1649A

E18
EN

E18
EN

C32
OPT
0603

C32
OPT
0603

C27
OPT
0603

C27
OPT
0603

+ C16
330uF
10V

+ C16
330uF
10V

R14 0

0603

R14 0

0603

JP1JP1

R16
0
0603

R16
0
0603

E12
CPGAIN

E12
CPGAIN

C31 1.0uFC31 1.0uF

J12
GND

J12
GND

C23
0.01uF
C23
0.01uF

C15 470pFC15 470pF

J7
RF-

J7
RF-

+C33

35V

47uF

7361

+C33

35V

47uF

7361

RZ_P
806
0603

RZ_P
806
0603

C5
1.0uF
C5
1.0uF

J3
CP

OPT J3
CP

OPT

C8
470pF

C8
470pF

C17
0.1uF
C17

0.1uF

R1
4.99K
R1
4.99K

C2
0.1uF 0805

C2
0.1uF 0805

C45
0.01uF
C45
0.01uF

E13
V+VCO

E13
V+VCO

C12
1.0uF
C12
1.0uF

C11
0.1uF
C11

0.1uF
J4

CPGAIN

OPTJ4

CPGAIN

OPT

CI2_A OPT

1206

CI2_A OPT

1206

J5
EXT VCO IN

J5
EXT VCO IN

R17
OPT
0603

R17
OPT
0603

R5 51.1R5 51.1

J93.3V J93.3V

J1

REF0

J1

REF0

E3
CP

E3
CP

C6 0.1uF

0805

C6 0.1uF

0805

R2
4.99K

R2
4.99K +C1

35V

47uF

7361

+C1

35V

47uF

7361

E15
V+VCXO

E15
V+VCXO

C38
100pF
C38
100pF

D1
LN1251C

D1
LN1251C

21

C21 0.1uF

0805

C21 0.1uF

0805

R23 OPTR23 OPT

CP_A
OPT 0603

CP_A
OPT 0603

CI2_P 0.1uF

1206

CI2_P 0.1uF

1206

C24
0.1uF
C24

0.1uF

C29
100pF
C29
100pF

E11
V+OA

E11
V+OA

C30
0.1uF

C30
0.1uF

CI1_A OPT

0603

CI1_A OPT

0603

C25
OPT
C25
OPT

A

B

U2
LT1678IS8

A

B

U2
LT1678IS8

1
OUTA

2
-INA

3 +INA
4

V-
5

+INB

6
-INB

7
OUTB

8
V+

E17
GND

E17
GND

R15
OPT
0603

R15
OPT
0603

CI1_P OPT

0603

CI1_P OPT

0603

R24 OPTR24 OPT

C18
1.0uF
C18

1.0uF

J6

RF+

J6

RF+

U4

OPT

U4

OPT

VTUNE
1

EN
2

GND
3

RFOUT
4

NC
5

VCC
6

J11
5V

J11
5V

L2
68nH
L2
68nH

C34 0.01uFC34 0.01uF

+

C3
330uF
10V

+

C3
330uF
10V

C28 OPTC28 OPT

C35 0.1uF

0805

C35 0.1uF

0805
U3U3

GND
1

VTUNE
2

GND
3

GND
4

G
N

D
5

G
N

D
6

G
N

D
7

G
N

D
8

GND
9

RFOUT
10

GND
11

GND
12

G
N

D
1
3

V
C

C
1
4

G
N

D
1
5

G
N

D
1
6

R13 OPT

0603

R13 OPT

0603

U1
LTC6945IUFD
U1
LTC6945IUFD

REFO
2

VCO-
15

STAT
3

M
U

T
E

9

SCLK
5

V+D
8

SDO
7

R
F

+
1
2

R
F

-
1
1

G
N

D
A

1
0

CS
4

VCO+
16

GNDB
17

V
+

R
F

1
3

V+REFO
1

B
B

1
4

SDI
6

GNDC
18

GNDD
19

GNDE
20

GNDF
21

V+VCO
22

G
N

D
G

2
3

V
+

C
P

2
4

C
P

2
5

V
+

R
E

F
2
6

R
E

F
+

2
7

R
E

F
-

2
8

G
N

D
2
9

C4
0.1uF
C4
0.1uF

J2

REF+

J2

REF+

E6
STATUS

E6
STATUS

L3
68nH
L3
68nH

+

C19

35V
47uF

7361

+

C19

35V
47uF

7361

C26 100pFC26 100pF
C42
100pF
C42
100pF

CP_P
8200pF

0603

CP_P
8200pF

0603

L1
OPT
L1

OPT

E14
GND

E14
GND

R10
0

0603

R10
0

0603

C37
100pF
C37
100pF

E16
GND

E16
GND

J10
GND

J10
GND

RZ_A OPT

0603

RZ_A OPT

0603

+

C7
20V
47uF

7343

+

C7
20V
47uF

7343

R4
330
R4
330



8

d
c1

6
4
9
afa

D
E
M

O
 M

A
N

U
A

L
 D

C
1

6
4

9
A

S
C
H

E
M

A
T
IC

 D
IA

G
R

A
M

N
ote: The buffers show

n on sheet 2 of 2 of the schem
atic are used to 

protect the LTC
6945 w

hen com
m

unicating to it starts before pow
ering it 

up. There is no need for such circuitry if the S
P

I bus is not active before 

pow
ering up the LTC

6945. The EEP
R

O
M

 is for identification and is not 
needed to program

 the LTC
6945.

A

A

B

B

C

C

D

D

E

E

4 4

3 3

2 2

1 1

DC590B SPI INTERFACE

0603

NOTE: EEPROM FOR BOARD IDENTIFICATION

3.3V

3.3V

3.3V

3.3V

CS

SCLK

SDI

SDO

SIZE

DATE:

.VER.ON CI

SHEET OF

TITLE:

APPROVALS

PCB DES.

APP ENG.

TECHNOLOGY
Fax: (408)434-0507

Milpitas, CA 95035
Phone: (408)432-1900

1630 McCarthy Blvd.

LTC Confidential-For Customer Use Only

CUSTOMER NOTICE
LINEAR TECHNOLOGY HAS MADE A BEST EFFORT TO DESIGN A
CIRCUIT THAT MEETS CUSTOMER-SUPPLIED SPECIFICATIONS;
HOWEVER, IT REMAINS THE CUSTOMER'S RESPONSIBILITY TO
VERIFY PROPER AND RELIABLE OPERATION IN THE ACTUAL
APPLICATION.  COMPONENT SUBSTITUTION AND PRINTED
CIRCUIT BOARD LAYOUT MAY SIGNIFICANTLY AFFECT CIRCUIT
PERFORMANCE OR RELIABILITY.  CONTACT LINEAR
TECHNOLOGY APPLICATIONS ENGINEERING FOR ASSISTANCE.

THIS CIRCUIT IS PROPRIETARY TO LINEAR TECHNOLOGY AND

SCHEMATIC

SUPPLIED FOR USE WITH LINEAR TECHNOLOGY PARTS. SCALE = NONE

www.linear.com

4

11/01/2011, 02:27 PM 2 2

ULTRALOW NOISE AND SPURIOUS INTEGER-N SYNTHESIZER

KIM T.

MICHEL A.

N/A
LTC6945IUFD

DEMO CIRCUIT 1649A

SIZE

DATE:

.VER.ON CI

SHEET OF

TITLE:

APPROVALS

PCB DES.

APP ENG.

TECHNOLOGY
Fax: (408)434-0507

Milpitas, CA 95035
Phone: (408)432-1900

1630 McCarthy Blvd.

LTC Confidential-For Customer Use Only

CUSTOMER NOTICE
LINEAR TECHNOLOGY HAS MADE A BEST EFFORT TO DESIGN A
CIRCUIT THAT MEETS CUSTOMER-SUPPLIED SPECIFICATIONS;
HOWEVER, IT REMAINS THE CUSTOMER'S RESPONSIBILITY TO
VERIFY PROPER AND RELIABLE OPERATION IN THE ACTUAL
APPLICATION.  COMPONENT SUBSTITUTION AND PRINTED
CIRCUIT BOARD LAYOUT MAY SIGNIFICANTLY AFFECT CIRCUIT
PERFORMANCE OR RELIABILITY.  CONTACT LINEAR
TECHNOLOGY APPLICATIONS ENGINEERING FOR ASSISTANCE.

THIS CIRCUIT IS PROPRIETARY TO LINEAR TECHNOLOGY AND

SCHEMATIC

SUPPLIED FOR USE WITH LINEAR TECHNOLOGY PARTS. SCALE = NONE

www.linear.com

4

11/01/2011, 02:27 PM 2 2

ULTRALOW NOISE AND SPURIOUS INTEGER-N SYNTHESIZER

KIM T.

MICHEL A.

N/A
LTC6945IUFD

DEMO CIRCUIT 1649A

SIZE

DATE:

.VER.ON CI

SHEET OF

TITLE:

APPROVALS

PCB DES.

APP ENG.

TECHNOLOGY
Fax: (408)434-0507

Milpitas, CA 95035
Phone: (408)432-1900

1630 McCarthy Blvd.

LTC Confidential-For Customer Use Only

CUSTOMER NOTICE
LINEAR TECHNOLOGY HAS MADE A BEST EFFORT TO DESIGN A
CIRCUIT THAT MEETS CUSTOMER-SUPPLIED SPECIFICATIONS;
HOWEVER, IT REMAINS THE CUSTOMER'S RESPONSIBILITY TO
VERIFY PROPER AND RELIABLE OPERATION IN THE ACTUAL
APPLICATION.  COMPONENT SUBSTITUTION AND PRINTED
CIRCUIT BOARD LAYOUT MAY SIGNIFICANTLY AFFECT CIRCUIT
PERFORMANCE OR RELIABILITY.  CONTACT LINEAR
TECHNOLOGY APPLICATIONS ENGINEERING FOR ASSISTANCE.

THIS CIRCUIT IS PROPRIETARY TO LINEAR TECHNOLOGY AND

SCHEMATIC

SUPPLIED FOR USE WITH LINEAR TECHNOLOGY PARTS. SCALE = NONE

www.linear.com

4

11/01/2011, 02:27 PM 2 2

ULTRALOW NOISE AND SPURIOUS INTEGER-N SYNTHESIZER

KIM T.

MICHEL A.

N/A
LTC6945IUFD

DEMO CIRCUIT 1649A

C44
0.1uF
C44
0.1uF

SDOSDO

R8
200K
R8
200KR26

4.99K
R26
4.99K

E
E

P
R

O
M

A
R

R
A

Y

U8
24LC025-I /ST

E
E

P
R

O
M

A
R

R
A

Y

U8
24LC025-I /ST

SDA
5

V
C

C
8

A0
1 A1
2 A2
3

G
N

D
4

WP
7

SCL
6

SCLKSCLK

GND VCC

U5
NC7WZ17P6X

GND VCC

U5
NC7WZ17P6X

1 6

43

52

WPWP

R7
200K
R7
200KR27

4.99K
R27
4.99K

GND DIR

VCC(A) VCC(B)

U7
74LVC1T45GW

GND DIR

VCC(A) VCC(B)

U7
74LVC1T45GW

1 6

43

52

R22 100R22 100

SDISDIV+DIGV+DIG CSCS

C39
0.1uF
C39
0.1uF

C41 0.1uFC41 0.1uF

R9
0
R9
0

R25
4.99K
R25
4.99K GND VCC

U6
NC7WZ17P6X

GND VCC

U6
NC7WZ17P6X

1 6

43

52

R21

100

R21

100

C36
0.1uF
C36

0.1uF

EEGNDEEGND

C43
0.1uF
C43
0.1uF

R12
100
R12
100

R18
200K
R18
200K

J8
HD2X7-079-MOLEX

J8
HD2X7-079-MOLEX

MOSI/SDA
7

EESDA
9

V+
1

5V
2

CS
6

SCK/SCL
4

EEVCC
10

MISO
5

EESCL
11

EEGND
12

AUX
14

G
N

D
3

G
N

D
1

3

G
N

D
8

R19
200K
R19
200K



9

dc1649afa

DEMO MANUAL DC1649A

Information furnished by Linear Technology Corporation is believed to be accurate and reliable. 
However, no responsibility is assumed for its use. Linear Technology Corporation makes no representa-
tion that the interconnection of its circuits as described herein will not infringe on existing patent rights.

LAYOUT TOP LAYER

The top metal layer of DC1649A is shown here as an example of good PCB layout for the LTC6945.
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DEMONSTRATION BOARD IMPORTANT NOTICE

Linear Technology Corporation (LTC) provides the enclosed product(s) under the following AS IS conditions:

This demonstration board (DEMO BOARD) kit being sold or provided by Linear Technology is intended for use for ENGINEERING DEVELOPMENT 
OR EVALUATION PURPOSES ONLY and is not provided by LTC for commercial use. As such, the DEMO BOARD herein may not be complete 
in terms of required design-, marketing-, and/or manufacturing-related protective considerations, including but not limited to product safety 
measures typically found in finished commercial goods. As a prototype, this product does not fall within the scope of the European Union 
directive on electromagnetic compatibility and therefore may or may not meet the technical requirements of the directive, or other regulations.

If this evaluation kit does not meet the specifications recited in the DEMO BOARD manual the kit may be returned within 30 days from the date 
of delivery for a full refund. THE FOREGOING WARRANTY IS THE EXCLUSIVE WARRANTY MADE BY THE SELLER TO BUYER AND IS IN LIEU 
OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR STATUTORY, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS 
FOR ANY PARTICULAR PURPOSE. EXCEPT TO THE EXTENT OF THIS INDEMNITY, NEITHER PARTY SHALL BE LIABLE TO THE OTHER FOR 
ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES.

The user assumes all responsibility and liability for proper and safe handling of the goods. Further, the user releases LTC from all claims 
arising from the handling or use of the goods. Due to the open construction of the product, it is the user’s responsibility to take any and all 
appropriate precautions with regard to electrostatic discharge. Also be aware that the products herein may not be regulatory compliant or 
agency certified (FCC, UL, CE, etc.).

No License is granted under any patent right or other intellectual property whatsoever. LTC assumes no liability for applications assistance, 
customer product design, software performance, or infringement of patents or any other intellectual property rights of any kind.

LTC currently services a variety of customers for products around the world, and therefore this transaction is not exclusive.

Please read the DEMO BOARD manual prior to handling the product. Persons handling this product must have electronics training and 
observe good laboratory practice standards. Common sense is encouraged.

This notice contains important safety information about temperatures and voltages. For further safety concerns, please contact a LTC applica-
tion engineer.

Mailing Address:

Linear Technology

1630 McCarthy Blvd.

Milpitas, CA 95035

Copyright © 2004, Linear Technology Corporation
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